SILICON LABS

OTA Upgrading Worksheet

In this worksheet we provide a step-by-step guide to create, build
and run Z3GatewayHost sample and ZigbeeMinimal applications
based on EmberZNet Stack 6.6.4. If you use a later release in the
future, most of the instructions should still apply, although there
could be minor differences not foreseen at the time of this
document.

These exercises help you get familiar with ZigBee 3.0 in the EmberZNet Stack, Simplicity
Studio v4 development environment, and the Wireless Start Kit (WSTK) with EFR32MG
modules. We assume that you have a WSTK and the following software requirements:

=  Simplicity Studio 4

= EmberZNet 6.6.4

= GCC7.2
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1 Pre-requisites

Make sure you have installed the EmberZnet 6.6.4 SDK and GCC toolchain on your PC.
1.1 Check EmberZnet SDK
1. Launch Simplicity Studio v4.
2. “Windows”->"Preference”->"Simplicity Studio”>"SDKs”, make sure “EmberZnet 6.6.4” is installed

=1 Preferences X
type filter text 5DKs (=R v v
g;gf’j‘ Check the SDKs available for project build configurations.
Help Checked entries are displayed when configuring projects.
Install/Update -
Network Analyzer Name Version Location Select Al
Run/Debug (] Bluetooth SDK Lite 220 CiiliconLabsSimpli p blelite\v2.2.0.0\ T
 Simplicity Studio [ Gecko SDK Suite: Bluetooth 2.10.1.0, EmberZNet 6.4.1.0, Flex 2.4.1.0, MCU 5.6.1.0, Micrium OS Kernel, Thread 2.8.0.0 241 Casiliconabs\SimplicityStudio\v4\developer\sdks\gecko_sdk_suitew2.4\ clect None
Adapter Packs [ Gecko SDK Suite: Bluetooth 2.11.5.0, EmberZNet 6.5.5.0, Flex 2.5.5.0, MCU 5.73.0, Micrium OS Kernel 5.6.0, Thread 29.5.0 255 Casiliconabs\SimplicityStudio\v4\develope\sdks\gecko_sdk_suitew2.5\
Crypto Profiles Gecko SDK Suite: Bluetooth 2.12.4.0[EmberZNet 6.6.4.0]Flex 2640, MCU 5.8.40, Micrium OS Kerel 5.7.0, Thread 2.10.40 264 CaSiliconLabs\SimplicityStudic\v4\developensdks\gecko_sdk_suite\v2.61
Device Filtering [ Gecko SDK Suite: Bluetooth 2.8.1.0, EmberZNet 6.2.3.0, Flex 2.2.2.1, Kernel, MCU 5.4.0.0, Micrium, OS, Thread 2.6.2.0 222 Co\siliconabs\SimplicityStudio\v4\developer\sdks\gecko_sdk_suitew2.2\, Add
Device Manager [ Gecko SDK Suite: Bluetooth 2.9.2.0, EmberZNet 6.3.1.0, Flex 2.3.1.0, Kernel, MCU 5.5.1.0, Micrium, OS, Thread 27.1.0 221 Co\Siliconabs\SimplicityStudio\v4\developer\sdks\gecko_sdk_suite\w2.3\ —
Energy Profiler [] Gecko SDK Suite: EmberZNet 5,10.20, MCU 5220 1 Ca\siliconLabs\SimplicityStudio\v4\developersdks\gecko_sdk suite\wl. T\ =
Launcher [ Gecko SDK Suite: EmberZNet 59.2.0, MCU 5.1.3.0 101 Ci\Siliconabs\SimplicityStudio\v4\developer\sdks\gecko_sdk suite\1.0\
Offline Content [ Gecko SDK Suite: EmberZNet 6:0.3.0, Flex 20, 202 Ci\Siliconlabs\SimplicityStudio\v4\developersdks\gecko_sdk_suiteWw2.01
Preferred IDE [ Gecko SDK Suite: EmberZNet 6.1.0.0, MCU 53.50, Micrium 05 Kernel 5.20 210 C:\SiliconLabs\SimplicityStudio\v4\developer\sdks\gecko_sdk_suiteWw2.T
SDKs [] Stackless applications 100 (none)
Systemuien
Tergets
Toolchains
User Experience
Wine location
Team
Wireless Development
Description: More details

Select an entry to see a description

Need more $DKs? Customize your installation here...
©) o
Figure 1 Check SDK in Simplicity Studio

1.2 Check Toolchains
1. Launch Simplicity Studio v4.
2. “Windows”->"Preference”->"Simplicity Studio”->"Toolchains”, make sure GCC toolchain is installed.
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<1 Preferences
type fifter text Toolchains
> General

S /e Manage the toolchains available for MCU project build configurations.
> Help
> Install/Update
> Network Analyzer Name Location Version
> Run/Debug GNU ARM v7.2.1 CasiliconL. P _em'7.2 2017qd\ 7212070004 |
~ Simplicity Studio AR ARM C\Program Files GEENAR Systems\Embedded Workbench 6.3 2401212
> Adapter Packs
Crypto Profiles
Device Filtering

Each checked entry in this list will be a candidate for automatically generating the build configurations in MCU projects,

> Device Manager

Energy Profiler
Launcher
Offline Content
Preferred IDE
SDKs
Systemiiew
Targets
Toolchains
User Experience
Wine location

> Team

> Wireless Development

Description:

Select an entry to see a description

Select Al

Select None

Add...

Remove...

More details

Need more toolchsins? Customize your installation here.

Figure 2 Check Toolchain in Simplicity Studio

1.3 Install the software tools:
1. Cygwin;

Extract the package cygwinx86.rar and copy it to the root directory of disk C.

Cancel

You can also extract the package cygwinx86.rar to other location as long as there is only ASCII characters in the path. In this case you

will need to modify the file “cygwin_here.reg” and modify the path according to your location.

Windows Registry Editor Version 5.00

[HKEY CLASSES ROOT\Folder\shell\open cygwin]
@="Open Cygwin Here"

[HKEY CLASSES ROOT\Folder\shell\open cygwin\command]
@="C:\\cygwinx86\\bin\\mintty.exe /bin/sh -1lc 'cd \" cygpath \"%V\" '\"; bash'"

[HKEY CLASSES ROOT\Directory\Background\shell\open cygwin]
@="Open Cygwin Here"

[HKEY CLASSES ROOT\Directory\Background\shell\open cygwin\command]
@="C:\\cygwinx86\\bin\\mintty.exe /bin/sh -1lc 'cd \" cygpath \"$V\" \"; bash'"

Double click “cygwin_here.reg” then select a folder and right click, check if there is a menu to start Cygwin in this folder.
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Expand

Open in new window

Eﬂpen Cygwin Here j

Pin to Quick access

Open in Visual Studio

Git GUI Here

Git Bash Here

dos here

powershell_here

7-Zip >
CRC SHA >

Figure 3 Right-click menu to start cygwin

1.4 How to flash the program
1. Start Simplicity Studio, then connect your device to PC;
ELIE
2. Inthe menu bar, find the icon ' for “Flash Programmer”, press it;
3. In the popup window, select the device;

= >

Select a device to program

—l J-Link Silicon Labs (440088231 : EFR32MG1P132F256GM48
T UEENEIE L )-Link Silicon Labs (440123943) : EFR32MG12P433F1024GL125

O |
%

Select Device

Flash Part
File

[BFDWSE...

Advanced Se

E’ragrar‘n
[ Rermember my decision

QK Cancel

@ Close

Figure 4 Select device
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4. Then in the next window, click “browse” to select the generated image ( .s37 or .hex) of your project, press “Program”. You can
also press “erase” if needed. Normally you just need to erase the device once before when you start the hands-on. The gener-
ated image is in the binary folder of your project. You can select it in “Project Explorer”.

v 135 Z3LightSoc [GNU ARM w7.2.1 - Default] [EFR32MG12P332 T =
v {;? Binaries ~ Application co
ﬁ: Z3LlightSoc.axf - [arm/le]

Generation direc
) Z3LightSoc.bin - [unknown/le]

{2 ZilightSoc.gbl - [unknown/le] Select architec
L3LightSoc.hex - [unknown/leg] l.l Board: EFR3.
i} Z3Llight50c.s37 - [unkr - "= ! PSR S e
it Includes e >
[= adc Open
[=- aes-cmac .
>
[== antenna-stub Open With
(= basic 2 Copy Ctrl+C
= ccmtencr}rptmn Paste Ctrl+V
[= coexistence-stub
= color-control-server Delete
= counters Move...
= debug-basic-library Rename... F2
= debug-jtag
E? efri2 |mF|‘D‘|"t »>
[= ember-minimal-printf 2" Refresh F5
= emdry
= emlib Run As »
Eﬁ external-generated-files Debug As 3
. == find-and-bind-target Profile As N
n 5 Team »
Debug Adapters &% | o= Outline Compare With N
I —
P R [AX Replace With 3

J-Link Silicon Labs (44012851¢
Browse Files Here

@ Open Command Line Here
[ Flash to Device.. ]

Properties Alt+Enter

Figure 5 Select image
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= Flash Programmer O *
e
Device

Board Marme; Wireless Starter Kit Mainboard

Board Mame: EFR32MG12 2400915 MHz 19 dBrm Dual Band Radio Board

MCU Mame: EFR32MG12P433F1024GL125

Adapter
Mame: I-Link Silicon Labs (440123943)

Flash Part

File Type ®hex Obin  Base address 00

File Please enter a valid path

| =
Advanced Settings...
Flash Erase/Write Protection

elect flash range W A = v | Ox100000 Y
®select s ang

() Select default sections Lock Main Flash Lock User Page

Protect Remove Protection

Debug Lock Tools

The unleck function only works using Silicon Labs EFM32 and EFR32 boards.
Unlocking the chip will erase all data on flash and SRAM.

Unlock Debug Access | | Lock Debug Access

?\ Close
Figure 6 Flash application

1.5 How to open console

Simplicity Studio has integrated a console so that it's convenient to debug through console. To use the console, you need:

1 Simplicity IDE
1. Change to “Simplicity IDE” perspective

2. Select your adapter in the “Debug Adapters” window, right click and select ‘connect”;
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3. Select your adapter in the “Debug Adapters” window, right click and select “Launch console”;
# Debug Adapters :° 5= Outline ‘ = B
PAEARRKUBI-EEEH

J-Link Silicon Labs (44017012
Rename

Disconnect

Start capture

Start capture with options..
Stop capture

Redo last upload

Upload application..
Upload adapter firmware...

Make a sniffer

I Sniffer Configurator..

Eaunch Console.. j

38 Device configuration..

| Force Unlock..

=) Open SWO Terminal...

- -

Figure 7 Launch console

1.6 How to start Capture

1 Simplicity IDE

1. Change to “Simplicity IDE” perspective :
2. Select your adapter in the “Debug Adapters” window, right click and select “connect”;
3. Select your adapter in the “Debug Adapters” window, right click and select “Start Capture”;
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¥ Debug Adapters ©7 5= Outline | = B

X AXBESG-EE2E R

J-Link Silicon Labs (4401ec1&
Rename

Disconnect

Start capture

Start capture with options..

Stop capture

Redo last upload

Upload application..
Upload adapter firmware...

Make a sniffer

I Sniffer Configurator..

Launch Console...

38 Device configuration...

Force Unlock...

LR

| Open SWO Terminal...

Figure 8 Start Capture

2 Build the bootloader for OTA client

Go to File -> New -> Project. This will bring up the New Project Wizard
Select “Silicon Labs AppBuilder Project”. Click Next.

Select “Gecko Bootloader”. Click Next.

Select the latest version. (Gecko Bootloader 1.9.2). Click Next.

Select “SPI Flash Storage Bootloader (single image)”. Click Next.
Name your project (Whatever name you want). Click Next.

Select board and compiler. Then finish.

Noookrowh =
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O x
Project setup ——

-c':"y
X

Select the board, part, and initial build configurations.

Boards:

Search | W

EFR32MG12 2.4GHz 10 dBm (BRD4162A Rev ADT) *

Part:
| Search | W
| EFR32MG12P332F1024GL125 |
Check the configurations to include in the project
v GMU ARM v4.9.3 E Select All i
Diefault
Select Mone

Diefault

Manage toolchains...

Manage build targets...

Figure 9 Select board and compiler

8. The new project should have been created now, with the project configuration file (an .isc file) open.

9. Click “Generate”. Notice the project files appearing in Project Explorer. A window saying Generation successful will appear.
Click OK.
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10. Select the project in Project Explorer window and compile your project by clicking on the Build icon % . Ensure that the build
completes with O errors.

3 Build the old version client image

Go to File -> New -> Project. This will bring up the New Project Wizard

Select “Silicon Labs AppBuilder Project”. Click Next.

Select “Silicon Labs Zigbee”. Click Next.

Select our latest EmberZNet stack for Soc (in this case EmberZNet 6.6.4 GA Soc). Click Next.

Select “ZigbeeMinimal”. Click Next.

Name your project, such as “Client”. Click Next.

In next window (Project Setup), select board to BRD4162A, and compiler to “GCC v7.2” (If you don’t have it, please install any
other). Click Finish.

Nookrwdh ==
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O x
Project setup ——

-c':"y
X

Select the board, part, and initial build configurations.

Boards:

Search | W

EFR32MG12 2.4GHz 10 dBm (BRD4162A Rev ADT) *

Part;
| Search

| EFR32MG12P332F1024GL125 |

Check the configurations to include in the project

v [7] GNU ARM v4.3.3 E
Diefault

Select Al {

Select Mone

Diefault

Manage toolchains...

Manage build targets...

Figure 10 select board and compiler

8. In “ZCL Clusters” tab,
a. In“ZCL device type” field, set “ZCL device type” to “HA On/Off Switch”

silabs.com | Smart. Connected. Energy-friendly
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'..'!, General |v'.5,. ZCL Clusters _ &% ZigbeeStack &% Printing and CLI @ HAL 0 Pluging | S Callbad

Clusters

Manufacturer (name or code): | Ember [0x1002]

Multiple endpoint configuration

Endpo.. Profile.. Device.. Version Configuration Network New

1 Hom... 0x0000 1 Pri Pri
25| om rimary rimary Delete

Selected configuration name: Primary

ZCL device typ | HA On/Off Switch hd I

SRS

Figure 11 select device type

b. Enable the client side of “Over the Air Bootloading”

o General A ZCL Clusters &% Zigbee Sta:k] % Printing and CLI 1. HALW'@* P\ugmswg Callbacksw F 9 In:ludesw o Other options} B Bluetooth GA'I'I']
Clusters
Manufacturer (name or code): | Ember [0x1002] v| Default response policy: | Always -
Multiple endpoint configuration Selected cluster description:
Endpo... Profile.. Devic.. Version —Configuration Metwork New This cluster contains commands and attributes that act as an interface for ZigBee Qver-the-air bootloading.
21 OxFFFF  OxFFFF 1 Primary Primary Delete
o Attributes . %y cDmmands] “e Repomnﬂ
Toggle all optional attributes
Selected configuration name: Primary
ZCL device type: R G - I Client / Serv... Attribute name Attr D Manufacturerco.. £ F 5 Type B Default
Server cluster revision OxFFFD INT16U 0x0001
= 4 | Server reporting status OxFFFE ENUME
Cluster name Cluster... Client Server Mfg Id v | Client OTA Upgrade Server ID (0000 j j j EEE_A. CofFAEE..
© & General ¥ Client Offset (address) into the file 0:0001 1171 nT3au s
o Basic w0000 || ] D Client OTA Current File Version 00002 INT32U D FEFFFFF
*, Power Configuration 00001 = | D Client OTA Current ZigBee Stack Version 00003 INT16U OueffEf
*, Device Temperature Configuration 0x0002 i i [ ] Client OTA Downloaded File Version 00004 INT32U CufFFFFFE
*, Identify 0x0003 : : D Client OTA Downloaded ZigBee Stack Ve...  0xD003 INT16U aeffEf
*, Groups cooos || _ ¥ Client OTA Upgrade Status 00006 1177 enumse 000
., Scenes 00005 [ ] ] Client Manufacturer ID 00007 INT16U
*, On/off 00006 || L [ Client Image Type ID 00008 INT16U
*e On/off Switch Configuration 00007 : : [ ] cient Minimurn Block Request Period 00009 INT16U
&, Level Control oo00s || ] [ Client Image Stamp OHODOA INT32U
*, Alarms 00008 [ ] il [] Client Upgrade Activation Palicy Dx000B ENUMS 000
®s Time O000A || L ] Client Upgrade Timeout Policy 0x000C ENUME 0x00
s RSSILocation 00008 || L v Client cluster revision OxFFFD 111 mmew ] oxoo0m
s Binary Input (Basic) 0x000F || L [ ] Client reporting status OxFFFE ENUME
*, Commissicning D015 | | [
*, Pariition 00016 [ | ]
[« Over the Air Bootloading 0x0019  [v] O]
o Power Profile GO0TA | L]
*y Appliance Control 0018 : :
&, Poll Control 00020 [ L]
=, Key Establishment 0800 || ]

Figure 12 Cluster setting

9. Turn to “plugins” tab, select the following plugins:
a. |Install Code Library
b. OTA Bootload Cluster Client
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c. OTA Bootload Cluster Client Policy, in the properties page, set the firmware version to 100.
# General |4 ZCL Clusters [ Zigbee Stack | Printingand CLI (@ HAL |4 Plugins & Callbacks | & Includes | & Other options | ) Blutooth GATT |

Plugin configuration

Use this section to select or unselect the plugins that you want to use in your application

‘ ‘ || Plugin: 4= OTA Boctload Cluster Client Policy
[#] 4= Strong Random, provides API: strong-random ]| Quality: W Production Ready (Certifiable)
[] =@ Throughput Description:
L] ¥modem Sender This is a sample implementation of how to define the policies of the Zigbee Over-the-air bootload cluster client (a multi-hop, application
[ ZCL Framewerk Core, provides APl: command-interpreter2 bootloader). |t allows the implementor to decide what manufacturer ID, image type ID, and file version informatoin is used for when querying the
[] <= Zigbee Event Lagger Stub, provides API: zighee-event-logger server. It also defines a couple callbacks that are fired, such as download complete and ready te bostload.
<> mbed TLS, provides API: mbedtls
[] <= mbed TLS Multiprotocol Configuration, provides API: mbedtls-canfig-multiprotocol
~ [m]% ZigBee 3.0
O
b .
E-ﬁx HA Device Trust Center Link Key Update Options: —
[[] <= Network Creator, provides APl: network-creator Image Type ID:[0-65535] 0 |
[] <= Metwork Creator Security, provides APl: network-creator-security G- g ] |
<= Network Steering, provides API: network-steering
g Update TC Link Key, provides APl update-tc-link-key Hardware Version:[0-65533] | 0 |
~ [0 ZigBee Light Link Perform EBL Verification (SOC Only)
O [include Hardware Version
Eﬁ [ Delete Failed Downloads
O Details (double-click on files to show content):
O« (= Located ot: CA\SiliconLabs\SimplicityStudic\vi\developerisdksigecke_sdk_suitelv2 6\ protecolizig happl A\app ol
O > §&, Common source files (1)
O== > & Implemented callbacks (4)
O 5> <> Required plugins (1)
O > 4~ Options (6)
O« > i Plugin extensions (1)
O«
~ [§] % ZigBee OTA Bootloading
<= OTA Boatload Cluster Client, provides APl: ote-client
=j- OTA Boatload Cluster Client Palicy
otload Cluster Common Code
< >
<= OTA Boatload Cluster Sterage Commen Cede
<= OTA Cluster Platform Bootloader
[] <= OTA POSIX Filesystem Storage Module
< OTA Simple Storage EEPROM Driver
<= OTA Simple Storage Module
[] <= OTA Simple Storage RAM Driver S

Figure 13 firmware version

OTA Bootload Cluster Common Code

OTA Bootload Cluster Storage Common Code
OTA Cluster Platform Bootloader

OTA Simple Storage Module

OTA Simple Storage EEPROM Diriver, in the properties, set the “read-modify-write” option to “false”

Se oo
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OTA Upgrading Hands-on Guide

& General f.!S. ZCL Clusters f:. Zigbee Stack f:. Printing and CLI f. HAL f—a:: Plugine . & Caubackﬂ:. \n:\udes).‘. otheroptmnﬂ Bluetooth GATFW

Plugin configuration
Use this section to select or unselect the plugins that you want to use in your application

‘ ‘ || Plugin: <> OTA Simple Storage EEPROM Driver
A<= Strong Random, provides APL: strong-random a || Quelity: f Production Ready
=@ Throughput Description:

L[> Xmodem Sender This is a driver for the Over-the-air simple storage madule plugin. It uses an EEPROM as the underlying storage device. It provides a means to
[A1=0= ZCL Framework Core, provides APl: command-interpreter2 record the actual data being read or written, as well as meta-data with infermation about how far along a client download is. It can be used either
[1=@> Zigbee Event Logger Stub, provides API: zighee-event-logger by an OTA Client or an OTA Server.

[A<p> mbed TLS, provides API: mbedls

[]<¥> mbed TLS Multiprotocel Cenfiguration, provides APl: mbedtls-cenfig-multiprotecel

v [H 3 ZigBee 3.0

O
04 o
[]<0> HA Device Trust Center Link Key Update Options: _ ——
[]<0> Metwork Creator, provides API: network-creator SOC Bootloading Support
[0 Metwark Creator Security, provides APL network-crestor-security [JEM35x SOC Only: Enable 4.2 Application Bootloader Compatibility Mode
[ 9> Metwork Steering, provides API: network-steering Gecko Bootloader Storage Support: Do net useslots
[0 Update TC Link Key, provides APL update-tc-link-key
« [ Zighee Light Link Storage Slot To Save Images To: |
O« OTA Storage Start Offset: |
Sﬁ OTA Storage End Offset: |
O (FEPROM Device Read-modify-write Suppert:
Eﬁ Frequency for Saving Download Offset to EERROM (bytes): |
== Dreesitstdaublaaclick an filoc o cho,
Sﬁ = Located at: C:\SiliconLabs\SimplicityStudic\vd\developerisdks\gecke_sdk_suite\v2.6\protocolizigbee\toohappbuilderi. . \app\framewerkipl]
£, Common source files (3)
[ =
O S Implemented callbacks (7)
4 ; <= Required plugins (2)
~ [ ZigBee OTA Bootloading

S Defined callbacks (1)

[A1== OTA Bootload Cluster Client, provides APl: ota-client % Setup contributions (1)

[A1== OTA Bootload Cluster Client Pelicy

S oot
[]=@> OTA Bootload Cluster Commen Code «" Options (8)

== « Conditions (2)
== 3 Plugin extensions (1)

[ g OTA Bootload Cluster Storage Commen Code
[ g OTA Cluster Platform Bootloader
OTA POSIX Filesystem Storage Module A i
[EA=0> OTA Simeple Storage EEPROM Driver ]
[T OTA Simple Storage Module
[]<g> OTA Simple Storage RAM Driver

Figure 14 OTA Storage setting

10. Turn to “Printing and CLI” tab, enable the following debug options.
a. Unfold “Individual plugin debug printing”
i. enable “OTA Simple Storage EEPROM Driver”, both “compiled in” and “Enabled at start up”;
ii. enable “OTA Bootload Cluster Storage Common Code”, both “compiled in” and “Enabled at start up”;
iii. enable “OTA Cluster Platform Bootloader”, both “compiled in” and “Enabled at start up”;
iv. enable “OTA Bootloader Cluster Client”, both “compiled in” and “Enabled at start up”;
v. enable “OTA Bootloader Cluster Client Policy”, both “compiled in” and “Enabled at start up”;
vi. enable “OTA Simple Storage Module”, both “compiled in” and “Enabled at start up”;
b. Unfold “Application specific debug printing”
i. enable “OTA Bootloader Cluster”, both “compiled in” and “Enabled at start up”;
11. Click “Generate”. Notice the project files appearing in Project Explorer. A window saying “generating successfully” will appear.
Click OK.

12.Select the project in Project Explorer window and compile your project by clicking on the Build icon % . Ensure that the build
completes with O errors.

13.In the build directory, backup the following file to a new folder “V100”:
a. Client.ota
b. Client.s37

4 Build the new version client image
1. Open the isc file of the client project, turn to “plugins” tab, select the plugins “OTA Bootload Cluster Client Policy”, in the proper-
ties page, set the firmware version to 200.
2. Save and generate the project, then build.

3. In the build directory, backup the following file to a new folder “vV200":
a. Client.ota
b. Client.s37

5 Build the server

We will still use the Z3GatewayHost + NCP as the OTA server.
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The OTA server is already configured. If you have run the last hands-on successfully, then you can skip this step.

You can check it with the following steps:
1. Open the isc file of the host project, turn to “ZCL Cluster” tab, make sure the server side of “Over the Air Bootloading” is enabled.

& General [ J 7CL Clusters % Zigbee Stack | Printing and CLI | @ HAL | 41> Plugins | & Callbacks | & Includes | & Other options | £ Bluctooth GATT |

Clusters
Manufacturer (name or code): | Ember [(x1002] v| Default response policy: | Conditional
Multiple endpeint configuration Selected cluster description:
Endpo... Profile.. Devic.. Version Configuration Netwaork MNew
21 Hom.. 0x00.. 1 Primary Primary_| S
=242 Green.. 0x0061 1 GreenPower Primary
., Attributes . "y Commandq e Repﬂrtingw
Toggle all optional attributes
Selected configuration name: Primary
ZCL device type: Fiobes Cimtom - I Client / Serv... Attribute name Attr D Manufacturerco.. E F 5 Type B Default
B EA
Cluster name Cluster... Client Server Mfg Id K
v 4% General
*o Basic 0x0000  |v] i
*s Power Configuration 0001 L [
* Device Temperature Configuration 00002 | | [
*o Identify 0x0003 v i
*s Groups 0x0004 |v| [
*» Scenes 0x0005 |v] [
*s On/off 0x0006 || i
*s On/off Switch Configuration 0007 | | [
*» Level Control 0x0008 || ¥
%y Alarms 00009 | | [
*y Time 0x000A | | v
*4 RSSI Location C000B | | [
%4 Binary Input (Basic) CeDOOF | | [
*s Commissicning 00015 || [
%4 Partition 0x0016 L
{5_Over the Air Bootloading ] 0x0019 | | vl
*« Power Profile 0x001A | | i
*» Appliance Control [ - L A

2. Turn to “Plugins” tab, make sure the following plugins are enabled:
OTA Bootload Cluster Common Code

OTA Bootload Cluster Server

OTA Bootload Cluster Server Policy

OTA Bootload Cluster Storage Common Code

OTA POSIX Filesystem Storage Module

©® Q0T o
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6 Test

1. Flash the bootloader (xxx-combined.s37) and ncp (ncp.s37) image to WSTK (NCP);
2. Flash the bootloader (bootloader-storage-spiflash-single_xxx-combined.s37) and old version image (Client.s37) to your client.
3. In the “build/exe” folder under the host project, there should be a directory named “ota-files” (If it doesn't exist, create one). Copy
the new version of the Client.ota to this directory.
4. Find the COM port number of your NCP board.
a. Start a cmd window:

E 0O @

Best match

Command Prompt

App

Apps
M Visual C++ 2008 64-bit Command Prompt

& Visual C++ 2008 32-bit Command Prompt

@ Visual C++ 2008 64-bit Cross Tools
Command Prompt

Figure 15 start cmd window

b. Change to C:\SiliconLabs\SimplicityStudio\v4\developer\adapter_packs\serial. Then run command:

serial.exe -ports
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C:\SiliconLabs\SimplicityStudio\v4\developer\adapter_packs\serial>serial.exe -ports

{

"pOI"‘tS"

[

"Name" : "“COM3",
"0sSID" : "“COM3",
"SerialNumber"

"Name" : "COM17",
"OsSID"™ : "Com1i7",
"SerialNumber" : "©60440128516"

Figure 16 get COM port of the WSTK

5. Make sure your WSTK for NCP is disconnected in Simplicity Studio.
6. Start Cygwin, and switch to the directory of the Z3GatewayHost project, then switch to “build/exe” directory. Run the following
command to start the host:

/cygdr‘ive/c/Users-/Documents/v4_workspace_2 .6/Z3GatewayHost

$ cd build/exe/

— /cygdr‘ive/c/Users-/Documents/v4_workspace_2 .6/Z3GatewayHost/build/exe
5.

Z3GatewayHost.exe -p COM17

Reset info: 11 (SOFTWARE)

ezsp ver 0x07 stack type 0x02 stack ver. [6.6.4 GA build 180]

Ezsp Config: set source route table size to 0x0064:Success: set

Ezsp Config: set security level to 0Ox0005:Success: set

Ezsp Config: set address table size to 0x0002:Success: set

Ezsp Config: set TC addr cache to 0x0002:Success: set

Ezsp Config: set stack profile to 0x0002:Success: set

Ezsp Config: set MAC indirect TX timeout to Ox1EO00:Success: set

Ezsp Config: set max hops to OxO0lE:Success: set

Ezsp Config: set tx power mode to Ox8000:Success: set

Ezsp Config: set supported networks to 0x0001:Success: set
value : set end device keep alive support mode to 0x00000003:Success: set
Policy: set binding modify to "allow for valid endpoints & clusters only":Success:
Policy: set message content in msgSent to "return":Success: set
value : set maximum incoming transfer size to O0x00000052:Success: set
value : set maximum outgoing transfer size to 0x00000052:Success: set
Config: set binding table size to 0x0010:Success: set
Config: set key table size to 0x0040:Success: set
Config: set max end device children to 0x0020:Success: set
Config: set aps unicast message count to Ox000A:Success: set
Config: set broadcast table size to 0x000F:Success: set
Config: set neighbor table size to 0x0010:Success: set

NCP supports maxing out packet buffers

Ezsp Config: set packet buffers to 179

Ezsp Config: set end device poll timeout to 0x0001:Success: set
Config: set z11 group addresses to 0x0000:Success: set
config: set z11 rssi threshold to OxFFD8:Success: set
config: set transient key timeout to Ox00B4:Success: set
Endpoint 1 added, profile 0x0104, in clusters: 8, out clusters 20
Endpoint 242 added, profile OxAlEQO, in clusters: 0, out clusters 1
Client Init

Figure 17 Start host

You should be able to see the detail info of the OTA image:
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Found OTA file 'Z3SwitchSoc Ota 4167A.ota’
Manufacturer ID: 0x1002

Image Type ID: 0x0000
Version: 0x00000064
Header String: EBL Z3SwitchSoc Ota 4167A

Found 1 files

7. On the console of the host, run the following command to create a network.

plugin network-creator start 1

8. Program a install code string following the steps in section 7.1 of https://github.com/MarkDing/loT-Developer-Boot-
Camp/wiki/Zigbee-Hands-on-Forming-and-Joining . After that, derive a link key from the install code with the pro-
vided tool HashingTool.exe.

44 InstallCode Hashing Tool *

InstalliCode (>=6 Bytes) [1112233445566??88 j

Derived Link Key 416 18FCOCE3B0E 1445899548 16E31466 I

| Derive I

Figure 18 Derive link key from install code

9. On the console of the host, use the following command to open the network for the device:

//000B57FFFEA8EF42 is the Eui64 of the client
//41618FCOC83BOE14A589954B16E31466 is the install code derived link key

plugin network-creator-security open-with-key {000BS57FFFEA8EF42}
{41618FCOC83B0OE14A589954B16E31466}

10. Open console of the client, then run the following command to start joining.

plugin network-steering start 0

11. Add the NWK key to Simplicity Studio, then start to capture.
12. On the console of the client, use the following command to start OTA upgrading.

plugin ota-client start

13. On the console of the client, use the following command to check the firmware version.

plugin ota-client info
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